Landmark College

New Staff & Faculty Technology Readiness Guide

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome to Landmark College</td>
<td>2</td>
</tr>
<tr>
<td>Logging into the Network for the First Time (using Windows XP)</td>
<td>4</td>
</tr>
<tr>
<td>Hands on Tutorial: Sending an email to TLS</td>
<td>6</td>
</tr>
<tr>
<td>Email Policy</td>
<td>8</td>
</tr>
<tr>
<td>Email Attachments &amp; Archiving</td>
<td>9</td>
</tr>
<tr>
<td>The Portal</td>
<td>10</td>
</tr>
<tr>
<td>Your H:\ Drive</td>
<td>15</td>
</tr>
</tbody>
</table>
ITS Welcomes You to Landmark College

To get you up and running on your new computer, Information Technology Services (ITS) has provided the “Technology Readiness Guide”. We recommend that you, along with your supervisor, spend 15-30 minutes going through this guide. It will assist you in properly connecting to the Landmark network.

About IT

ITS, located on the second floor of the Landmark’s Library, provides operational and support services related to LMC’s network infrastructure and the administrative, teaching and learning uses of the campus’s computer technology, hardware and software.

Descriptions of our services and help tutorials are available at our website: http://intranet.landmark.edu/its/

Our specific services include:

**Database Services & Applications**  
PowerCampus/FAIDs (admissions and financial aid), Great Plains (financials), Raiser's Edge (development), ISIS (Internet Student Information System), Drake Center for Academic Support Visits Database, and new database applications.

**Contacts:**  
Kimber Ekstrom, Manager of Database Services x1670

**Digital Text Services** (now part of the Landmark College Library)  
Scanning of primary course texts and Coursepacks, management of access to course files, research & promotion of e-texts and content repositories.

**Contact:**  
Candace Brown, Digital Library Coordinator x6448

**Network Services**  
Security, connectivity, server management, bandwidth management, file saving and printing, anti-virus & spam management.

**Contact:**  
Kirt Sorensen, Manager of Network Services x1655  
Steve Holley, Network Specialist x1693

**Technology Learning Services**  
Technology Learning Services (TLS) offers 1-on-1 and classroom/group training on basic computer skills, Kurzweil 3000, Dragon
NaturallySpeaking, Inspiration, PowerPoint, Word, and GroupWise, Instruction on other computer graphics and web development programs is provided on a case-by-case basis.

**Note:** for training on the Digital Text Library, Internet Research Tools, Online Databases, WebCat (the online library catalog), and other Research Tools, please contact the Library.

**Contacts:**
Michael Nieckoski, Manager of Technology Learning Services x6339
Kathy Burris, Assistive Technology Coordinator and Educator x6892

---

**Tech Support Services (The Help Desk)**
Employee Support Categories

- IT support services for faculty and staff covers any and all issues related to the use of College-supported hardware and software. Additional software and peripherals can be requested and if approved will also be supported by IT Staff.

- Issues related to the use of personal software, peripherals and other hardware are not supported by ITS Staff.

**Contacts:** Help Desk x6800
Tina LaFlam, Manager of Technical Operations
Maria Nespolo, Technical Support Specialist
Cliff Nadeau, Technical Support Specialist

**Web Services**
Intranet, portal, bulletin board, ISIS, online forms, public website maintenance, and new web development.

**Contact:**
Joanne Patalano, Web Developer x6765

---

**About the LMC Network**

Landmark College maintains a wired and wireless local area network and high-speed connectivity to the Internet in support of its mission. This network provides tools for research and collaboration, communication, as well as systems for supporting the day-to-day functioning of the College. Key components of the network include Novell Netware File and Print services, Novell GroupWise for collaboration (email, calendaring, etc.), and apache servers for web services. Client's access the network using Windows XP (Macintosh and other operating systems are not supported). Network services run on a mix of Hewlett-Packard and Dell servers housed in the Library, which is the hub for the campus fiber-optic backbone.
Logging into the Network for the First Time (using Windows XP)

Who is Responsible for What?

The College is responsible for the Landmark network – all the wires, cables, and routers that connect computers and peripherals to each other and, beyond the campus, to the Internet – and permits and limits access to authorized users based upon need.

The College also owns all College-provided faculty and staff notebooks and desktop computers, computer labs, computing locations, and the software it has installed on them. The College determines who may use these resources and their acceptable use. Please also refer to the Network and Computer policy at http://intranet.landmark.edu/its/policies/use.shtml

1. **Turn on** your computer. The Novell Login in the image below should show up.  
   **Note:** If you first get a Ctrl+Alt+Del command, please execute this command.  
   **Type in your user name:** your first name followed by your last name as one word; i.e. jasonkidd is the username for Jason Kidd

   ![Novell Login](image)

2. Hit the Tab key—Don’t use the mouse (the tab key sets the context (Staff or Faculty) for your name)

3. **DON’T type in a password**—leave the password box empty

4. **Press Enter** (or click OK)

5. You will then see this dialog box asking if you want to change your password.
6. Click on YES.

7. The Change Password box appears.

8. **Wait to type anything:** You will be using this password for five programs—it must be at least 6 digits or letters in any combination, plus a special character: \/:*<>|+=[]!~$%^(). Choose something others won't easily guess.

9. **Type your desired password** in the Enter new password box.
10. **Retype the password** in the Retype new password box.
11. **Click on OK** to finish logging in.

You have created a password for your account on Landmark’s network and GroupWise Email.
To get you started with GroupWise, follow the steps below to send an email to staff and student trainer, Kathy Burris, from Technology Learning Services (TLS). As part of your orientation on using LMC’s technology resources for administrative, teaching and learning purposes, you will make an appointment with Kathy for further technology training. In your email indicate 2-3 times over the next week that you would be available to meet with Kathy for about 1 hour for continued training. She will get back to you soon via email with a confirmation.

Send a new email from the GroupWise client:

The GroupWise 'client' is the software program on your machine. It's called a client because it depends on interactions with the server to function. That's why you need to be logged in to the network to use it. LMC also offers access to GroupWise remotely, when you need to check your email off campus.

1. Log in to the network (either wirelessly or through an Ethernet cable connection).

2. Double-click on the 'GroupWise' icon on your desktop.

3. From the GroupWise menu, do File > New > Mail (or on keyboard, Ctrl + M) -or- select the new mail icon on the main menu bar:

A 'compose email' screen will open:
1. **Recipient's email address or name goes in the box next to 'To:'**
   If they are a Landmark College GroupWise user or their name has been entered into your GroupWise address book, GW will fill in the first matching name it finds. You can also click on the Address Book button to search for their email address.

   In this area type in the name “Kathy Burris” or kathyburris@landmark.edu

2. **Subject** is a standard convention in email to provide a subject to the message you are writing, so the people who receive it will quickly know what the message is about. This helps a lot when you are trying to organize your messages.

   In the subject line type “orientation training”.

3. In the box next to 'message:' enter the text of the email.

   Here, is where you will enter what days and times will work for you for further orientation training with Kathy.

4. To attach a document, click on the 'Attach' button on the right. An 'attach file' dialog box will open. Once you've successfully attached a file, the name of the file will appear in the pane below the message text. (see figure above)

   In your email to Kathy you will not need to attach a document. Just keep this feature in mind for future emailing.

5. Use **CC: ('carbon copy')** to send a copy of the email to someone.
6. **BC stands for Blind Copy.** You can send other people a copy of the message, but the people in the To and CC fields will not know that you did so. Be careful about using this feature as it is generally not an accepted e-mail practice.

7. Press 'Send' to send the email to Kathy. She will get back to you shortly with a confirmation.

**Email Policy**
The provisions of email service at Landmark College are listed in the complete policy. There are three parts of the policy that merit special attention in terms of unauthorized access or purpose and inappropriate content:

**Unauthorized Access**
The following constitute unauthorized forms of access:

- Permitting anyone else to send email using the username or email address that an email account holder has been given
- Sending email using another user’s username or email address
- Sending email from a unit username that an email account holder is not authorized to use
- Attempting to disguise the email address from which an email account holder’s message is sent or the identity of the sender

**Unauthorized Purposes**
The College’s email system is intended to support the College’s institutional activities and operational needs, and in principle, any other use is not permitted. In practice, limited or incidental use of email for personal purposes is regarded as acceptable, while use of email for the purposes listed below is not authorized:

- Private commercial use of the College’s email system
- Bypassing the compiled Faculty, Staff, and Students Messages that are sent in digest form
- Using email for any purpose which violates federal or state laws
- Using email for purposes that could reasonably be expected to cause, directly or indirectly, strain on the system, or interference with others’ use of email or email services

**Inappropriate Content**
Acceptable use of email is based on common sense, respect for others, and civility applied to the electronic communications environment. Moreover, it is important to note that the perception or reaction of the recipient is a major factor in determining if a specific communication is harassing, offensive, defamatory, or abusive. Various federal and state laws and College policies apply to this requirement.
About Email Attachments

Attachments are documents found on your computer that you can attach to and send in an email, like a photograph of your friends, your homework assignment, or your favorite MP3 song. Attachments can be a little tricky, however. You can attach files of any sort to messages. But there are some things to consider:

File Type - Make sure the person to whom you are sending an attachment CAN OPEN IT - meaning they need to have an application that can read this kind of file. For instance, if you send someone a .PDF file - they need to have Adobe Acrobat, or some other .PDF-reading application to view it. You should always make sure the person to whom you are sending an attachment can read it. Not sure? Then ask them.

File Size - If you send a file that is too large as an attachment, you can do damage to another person’s email account, computer or network - not to mention your own. NEVER send anyone an attachment that is over 10 megabyte (that’s 1,048,576 bytes).

Attachment Suspicion - Many people will not open attachments they received without being warned before hand. Attachments may be corrupted, and do damage to your computer. Also, many computer viruses are spread through attachments. Remember the Love Virus? That moved around as an attachment. Viruses can get into your address book and send themselves to your friends without you knowing it. You should ask someone if it’s ok to send them an attachment before doing so. That way, they know it’s coming, and you’ll know they’ll be able to read it.

Archiving Email Messages
(Note: Messages are only available for 6 months unless archived. This includes messages in your Inbox and messages you have filed in Folders.)

Email messages that need to be saved for an extended period of time should be archived. To archive messages, you need to right click on the message that you want to save and then select “move to archive”. If you want to archive multiple messages at once just click on the first message then hold Shift key and select the last message in the list or use ALT to select the messages individually. Menu option will appear as shown below:

Once the message has been moved you can always access it by clicking on File, Open Archive as shown below:
This process should be done for any messages you do not want deleted during the standard six month purge process. **This includes messages that you store in a folder under your cabinet.** When archiving cabinet folder messages you need to follow the same process as above and the folder will be created for you in the archive.

### The Portal

The Landmark College intranet is our internal information system: [https://intranet.landmark.edu](https://intranet.landmark.edu), has web pages and forms for many of the offices on campus. You can get a feel for what’s on the intranet by checking out the [sitemap](https://intranet.landmark.edu) (see Figure 1).

Note: The Landmark College intranet is also available for your use off-campus.

![Figure 1](https://example.com/figure1.png)

The portal is the home page. **If you login, you will get a more personalized experience. Some pages require that you log in.** (e.g. request forms, surveys, ISIS)

- events are targeted to your audience (Students, Faculty, Staff)
- new links will show up on the left in ‘Quick Links,’ such as the Student Directory and ISIS.
- you can add Bookmarks
- it will log you in to campus password-protected applications like GroupWise web access, IQWeb, and WebCT (you don't have to remember all of the passwords if you're logged in to the portal).
How do I log in to ‘the portal’?

1. Go to intranet home page at [https://intranet.landmark.edu](https://intranet.landmark.edu)
Enter your username and password:
   **Your username:** the same as your Network username, e.g. jasonkidd.

   **Your password:** until you change it, it will be same as the username above.
   If you forget your username & password (or they don’t work), use the “Click here if you’ve forgotten…” located just below the login boxes. (see Figure 2)

   ![Figure 2](image)

2. Click orange “LOG IN” button.
3. Page should now say, “Welcome, Your Name.”
   If it does not, use "Click here if you've forgotten your password" & it will be sent to you as an email in GroupWise.

How do I change my password?

1. Click on ‘My Prefs’ in the very top right of the page.

   ![Image of My Preferences page](image)

2. The ‘My Preferences’ page opens.
3. Under 'Edit Preferences', type the password you created earlier in the box next to 'Portal Password.' (This is not case-sensitive.)
4. Type your password again next to 'Confirm Password.'
5. If you will be using IQWeb we’re going to enter your password in one more place so the portal will log you in to IQWeb. If you are not using IQWeb continue to #7.
6. Scroll down and put your username and password in the boxes under IQWeb. Each time you'll need to enter your password twice. This is the password you've been using all along.
7. Now click the orange 'Update User' button.
8. Click on 'home' in the top right and let's see what we did.

Using IQWeb

IQWeb is an online program where you can search for course sections.

Logging In

There is a link to IQWeb on the portal home page (https://intranet.landmark.edu) If you haven't already set up your password in the portal during Orientation, complete steps 2-11.

Click on the login key. (see circle in picture below).

Enter your Network username next to Login ID. (see picture below)

Enter your Network username (again) next to Password. Click on the Sign In button.
Change Your Password

After you login, click on the Change Password link in the blue 'nav' on the left.

Enter your **Network username** next to 'Current Password.' (see picture below)

Enter a **password of your choosing** next to 'New Password.'

Enter your **password again** next to 'Re-enter New Password'

Enter your GroupWise email address

Enter a **hint to help you remember** your password (optional).

**Add some Bookmarks**

The portal will remember links to web pages for you. This is like using ‘Favorites’ in your browser, except that you can see them on **any machine you go to**, by logging in to the portal.
Go to the web page whose link you want to add, e.g., http://news.google.com.

Copy the address of the page: Click once in the URL/address bar (up top in the browser), so that it is selected. (Or drag over it with your mouse if necessary.) Look at the menu items up top in the browser (e.g., File, Edit, View) and do Edit>Copy.

Go to the intranet home page. (https://intranet.landmark.edu or use your Back button)

Log in if you haven’t already.

Click on ‘Add’ on the left. (Figure 5, #1)

Next to ‘Link Title,’ type the name you want to appear in your Bookmarks list (e.g., Google News) (Figure 5, #2)

Next to ‘Link URL,’ click in the box and do Edit>Paste, as in Step 3. (Figure 5, #3)

Click the orange Update Bookmark button. (Figure 5, #4) The link will now appear under My Bookmarks when you login, no matter what machine you go to.

Get Your Event Posted

If you’ve got an event happening at Landmark College, use the portal to let people know!

Click on the “Get Your Announcement Posted” link on the home page just below ‘Events Highlights,’ to use a form to submit an event posting request.

Appropriate listings include announcements of college-related happenings. If it is not clear to the webmaster if an event is indeed ‘appropriate,’ an associated division leader could be asked to sign off on the post. Events can be targeted specifically to: Students, Faculty, Staff, or any combination of those audiences.

If you’d like to post something more personal (ride request, lost item, rant about snow), use the Bulletin Board link on the right, under ‘Internet Tools’). The title of your post will appear on the home page. See Bulletin Board User Guide as follows.
Bulletin Board User Guide

General
Students, Faculty & Staff may register for the Landmark College Bulletin Board. We have 9 available 'forums' and are currently using 3: General, For Sale/Lost & Found, & Ride Board. While demand is low, an individual instructor or group could have their own forum. Students: if you have an idea for a board, contact Joanne, x6765, webmaster@landmark.edu

No login is required to read posts (except for ISIS forum), but login is required to post anywhere. In order to login, you first must register. Registrants must use their GroupWise user name or their Full Name for the 'publicly displayed name.' (read more below under 'Registration Process'

Bulletin Board Administrators and forum moderators can edit and delete posts and can ban individual users. This would only occur in the case of highly offensive posts.

The subject line of 'Recent Posts' appears on the intranet home page.
Location: https://intranet.landmark.edu/bulletinboard.
There is a link to the bulletin board on the portal home page on the right hand side, under 'Internet Tools.'

Registration Process
To register, fill out the registration form. You will then receive an email with your username and password. However, you will not be able to access the forum until your registration has been approved. (You will receive another email when that happens.)

Click on the home page link to Bulletin Board. Click Register. Read the agreement and click 'Agree.' The Registration Form opens.

Type your Login Name. It must be either your full name or GroupWise user name. Type your Publicly Displayed Name (this will appear next to posts): It must be either your full name or GroupWise user name.

Type your Email Address. It does not have to be your GroupWise email address.

Location, Occupation, Homepage, Interests, Your Picture, ICQ ID, AIM ID, and Birthdate, Signature, picture, and home page are all optional fields. If entered, they will be visible to other viewers in your profile. They can be added/edited by logging in and going to 'My Profile.' (link at top right of page)

The 'Preferences' features can be left as is. To learn more about some of the preferences, I recommend the FAQ. (e.g. you can find an answer to "What is a private message?")

Click 'submit registration.'
You will receive an email message with your username and password, and a warning that approval is necessary. You will then receive an email message with approval/denial. (It would only be denied if the names used don't match the criteria listed above.)

**Passwords**
Bulletin Board automatically assigns a “nonsense” password--e.g. TYUIO
You can change your password by logging in and going to 'My Profile' (link on top right).
*If you forget your password, click login. Next, click on:*

"» Lost Password? For assistance finding your registered login and/or password, click here."

Enter your **email address** and password will be emailed to you. I

**To change your password:**
**Login** to Bulletin Board

Click on ‘My Profile’ on the top right, under 'Landmark College Bulletin Board'.

Click on 'View/Update Profile' on left under 'My Profile'.

Type in a **new password**.

Scroll to the bottom of the page and click 'Update Profile.'

**To create a new post/reply to a post:**
**Login** to Bulletin Board

Click on the name of the **Forum** that best relates to the info you'd like to post.

If you'd like to reply to a post, click on that post.

Click on the gray **New Topic** button at the bottom of the Forum page. (or the gray **Post Reply** button at the bottom of the post)

Enter **Subject and Message** and whatever additional options you choose, including "Email Notification" at the bottom of the page. (email notification means that if someone replies to your posts, you will be notified by email at the email address listed in your 'My Profile' page.)

**Editing/deleting your posts**
You can edit or delete posts that you have made. To edit/delete a post:

**Login** to Bulletin Board
Choose the **Forum** with the Topic Name you want to edit, then find that Topic.

At the top of each post is the date it was posted in red, followed by icons. Click on the **icon with the pencil** (the Edit/Delete icon).

---

### Your H:\ Drive. What is it & how do you get to it?

To delete your post, **check the button near the top of the blue box**. To edit it, **make changes** within the body. **Click 'Edit Post' button** to submit the changes.

Everyone has a limited amount of storage space on the network (100mb).

This is called the H drive.

It is the best place to save documents, because you can access them from any campus computer.

Once you get to 100mb, you won't be able to save anything more to your H drive.

Anyone know how much 100mb is? (100 pg Word document could be ~1mb, mp3's average 4mb).

1. You have to be logged into the network (the first step in this guide).
2. Double click on the My Computer Icon on your desktop.
3. Scroll down so you can see 'Network Drives'

![My Computer Icon](image)

4. Your username on “Fileprn-srv\Admin\Home” should appear in the Network Drives section.
5. When you double click on that icon, the contents of your H: drive will appear.

6. We’re going to save something there in the next step, but in the future, when you save work and you want to put it on your H: drive, you’ll do ‘Save As’ and just try to remember that your H: is located in ‘My Computer.’

**How Do I save a document to my H Drive?**

1. Be sure you are logged onto the network.
2. Open the document you wish to save. Go to File > Save As.

   ![Image of File menu]

3. Click on the little triangle drop down arrow in the rectangle with your name in it.

   ![Image of drop-down menu]

4. Double click on your username on Mako\Vol1\.....
5. Enter the name of the document in the File name: box and then click on Save.

**How do I retrieve a document from my H Drive?**

1. Be sure that you are logged onto the Network.

2. Double click on the My Computer icon on your desktop.

3. Scroll down to your H Drive (Your username on Mako\Vol1…). Then double click on that icon.

4. The contents of your H drive are now displayed. Select the document you wish to open and double-click on it.